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GETTING STARTED

Barnes & Noble Press is pleased to offer the Barnes & Noble Press print platform for anyone who wants to make a profession-
al-quality print book of his or her work for sale or for personal use. For everyone from the professional author to the first-time 
writer, and small publishers to the individual craftsperson, the Barnes & Noble Press print platform is quick, easy-to-use and 
will deliver professional quality print books in about a week.  

To get the most out of the Barnes & Noble Press print platform technology, your interior text and cover need to be formatted 
as print-ready files. This guide offers formatting instructions and recommendations that will help you make your work print-
ready, so your printed book turns out just the way you want it to. This guide gives instructions for formatting your book in 
Microsoft Word. For instructions using Pages for Mac or Pages for iOS, see the appendix at the end of the guide.

Visit BNPress.com to learn more.
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To print a book with Barnes & Noble Press, you will need to have print-ready files for both the book interior and the cover. 
A Barnes & Noble Press print-ready file is a PDF (Portable Document Format) file for the cover, and either a PDF or Microsoft 
Word document for the interior, with certain formatting rules applied during creation. 

This formatting guide will provide tips on how to make sure your book and cover files are ready for our printers.

What is a Print-Ready File? 

Whether you’re a major book publisher or an independent author, the printing process starts the same way—with a print-ready 
PDF for the cover and either a PDF or MS Word document for the interior. 

Please note that just because a file has a .PDF or a .DOC extension that does not mean it is necessarily “print-ready.”   

Most authors write their books in a word processing software program, such as Microsoft Word, WordPerfect, Mac Pages, 
or Google Docs. These programs are perfect for the writing process, but may not be ideal for printing because what is shown 
on screen may not translate faithfully to the printer. Spacing and page breaks may differ, for example. A document that looks 
tidy online might appear awkward when printed, so if you’re uploading an MS Word document as your interior, be sure to 
double check your interior digital proof. Remember, too, that we don’t accept interior documents in WordPerfect, Mac Pages, 
or Google Docs.

While we accept print-ready MS Word documents for the interior, you may want instead to choose a print-ready PDF file for 
your interior, which will translate exactly what’s on screen to the printer. No matter the computer or machine, a PDF will print 
the same way because it’s in a “locked format.” Having a locked-formatted document is great for knowing exactly how your 
book will look when it’s printed. 

A print-ready PDF does have limitations, though. There are a few rules to make sure the PDF version of your manuscript 
results in a good-looking book. We’ll walk you through the steps for converting from a word document to a PDF if you choose 
to do so, and help you avoid the pitfalls of these limitations. 

For the more adventurous, there are design layout programs like InDesign from Adobe that provide more advanced 
features and finer controls for page design. It is also possible to create PDFs from these programs. For more 
information about converting InDesign files into PDFs, please visit http://helpx.adobe.com/indesign.html.

BOOK FILE REQUIREMENTS
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Preparing your text document is an important step in getting 
your manuscript ready for print. To help you create a print-
ready file, we’ll cover some basic book structure and design 
elements that you need to address.

Proofread and Spell-Check 
Read over your manuscript from start to finish, keeping an 
eye out for grammatical or other errors that might have 
crept in while writing. Use your word processor’s spell-check 
feature to check for typographical errors or misspellings. It’s 
often helpful to have a trusted friend or colleague read your 
work with a fresh eye.

Spacing and Text Placement
In general, it’s best to use paragraph styles to control the 
spacing before and after paragraphs and the insertion of 
page breaks in a text.

Using Hard Returns
Use “hard returns” or the Enter key for paragraph breaks 
only. DO NOT use a series of hard returns to indicate a new 
page. Using hard returns to indicate a page break will result 
in a messy book page when printing. Instead, use the page 
break or section break option in your word processor for 
this type of break. 

Keeping Text Reflowlable
Most word processors, including Microsoft Word, are re-
flowable, meaning they automatically flow words from line 
to line, making adjustments automatically when the user 
changes the window size. For the Barnes & Noble Press 
print platform, be sure to keep text reflowable; in most word 
processors, this is automatic. Plus, if your document’s para-
graph styles are set to full justified (flowing the text of com-
plete lines from the left margin to the right, as this paragraph 
does), hyphenation will be automatic. This will allow you to 
freely enter and edit text without manually breaking a word 
at the end of a line of text. 

Using the Space Bar
As a general rule, do not use the space bar to indent 
paragraphs or adjust the indentation or placement of other 
text elements. Use paragraph styles to automatically indent 
paragraphs, or use the Tab key. Do not use multiple spaces 
to indent paragraphs because it will not translate properly 
to a printed page. Also, if you want to center text, use the 

text-centering tool. Do not use the space bar to move lines 
visually across the page. These improperly used spaces will 
cause inconsistencies in layout when going through your 
final formatting process.

Book Layout and Elements
As you prepare your book, it’s helpful to keep in mind the 
following conventions used in book publishing.

Book Pages and Page Spreads
We count two book pages (e.g., page 1 and page 2) on a single 
sheet of paper. When we talk about a page in a book, we 
mean only one side of the paper. Each sheet of paper holds 
two pages: the front and the back. If there are 200 pages in a 
book, there are only 100 sheets of paper.

A spread is a book layout with two facing pages.
Odd-number pages appear on the right side of a spread. 
Even number pages appear on the left. Page 1 always begins 
on the right side, and establishes the pattern of odd/even 
used for the rest of the book.

PRE-PRESS MANUSCRIPT 
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The Book Block
In publishing, the collection of all the pages between the 
covers is known as the “book block.” Within the book block 
itself, there are usually three sets of pages:
•	 The Front Matter
	 The front matter includes the title page, the copyright 

page, a table of contents, and perhaps other elements, 
such as a foreword, a preface, and an epigraph. 

•	 The Core Matter
	 The core matter consists of the main content of a book: 

the narrative in a novel, the poems in a poetry collection, 
the essays in an essay collection, and so on.

•	 The Back Matter
	 The back matter consists of all the content that follows 

the core matter. This could include an epilogue, an after-
word, acknowledgements, a short profile of the author, 
and an index.

Front Matter
Front matter is the material in the front of the book, before 
the book narrative begins. Front matter is up to your 
personal preference, though it’s good to at least have a title 
page before the first narrative page. Except for the Table 
of Contents, these elements are typically one page each. In 
typical order of appearance:

Each of these elements is described below.

Title Page
The title page appears on the right and presents the full title 
of the book and the author’s name. 

Copyright Page
If your print book is for personal use, you do not need an 
ISBN to print your book using Barnes & Noble Press. If your 
print book is for sale, however, you must have an ISBN and 
should list it on the copyright page.

	 Under U.S. copyright law, your self-published work is 
protected as soon as you put pen to paper. Copyright is 
based on your creative authorship and is not dependent 
on any formal agreement with a book publisher or self-
publishing company, although registration with the U.S. 

	 Copyright Office is beneficial. 

	 Copyright registration allows you a higher level of security 
and confidence when it comes to protecting your work. 
When you register your work with the U.S. Copyright 
office, you create a public record of your authorship. Even 
though you are protected the moment you start writing, 
you’ll have to register your work with the Copyright Office 

	 to be officially recognized as the copyright holder in a court 
of law. The use of the copyright notice is the responsibility 
of the copyright owner.  For more information see 

	 http://www.copyright.gov/circs/circ01.pdf

You do not need to acquire your own ISBN to print your 
book using the Barnes & Noble Press print platform. How-
ever, if your book does have an ISBN, you should list it here.

Dedication
If an author wants to dedicate the book to a person or group 
of people, that dedication usually appears on its own odd-
numbered page. The dedication itself is often centered and 
set in italic like so:

To Mary, as always

Table of Contents
The table of contents follows next. Microsoft Word and 
other word processors include tools for automatically gen-
erating a table of contents to ensure it accurately reflects 
your latest changes to the document.

Epigraph
An epigraph is a quotation or group of quotations that the 
author feels set the tone for the book that follows. Like 
dedications, epigraphs might be centered on the page and set 
in italics. Quotations should always be attributed.

Optimism is the faith that leads to achievement.
                     —Helen Keller

Preface
A preface is an introduction written by the author of the book.

Foreword
A foreward is an introduction usually written by someone 
other than the author of the book. In nonfiction, the fore-
word might be written by another expert in the same field as 
the author.

•	 Title page 
•	 Copyright page
•	 Dedication page
•	 Table of contents

•	 Epigraph 
•	 Preface
•	 Foreword

PRE-PRESS MANUSCRIPT 
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The Core Matter
Chapter Breaks
Many books contain chapter breaks, but it’s not a  
requirement. If your manuscript does have chapter breaks, 
think about how they visually appear on the page. 

Usually chapter titles appear about a third of the way down 
the page. In your word processor, you might want to use a 
consistent Chapter Title paragraph style that specifies a set 
number of inches or points to make the  
title appear at a specific place on the page. Use paragraph 
styles rather than a series of hard returns to position titles 
and create blank space on a page.

The picture below shows how chapter breaks and  
chapter titles are typically formatted.

 	

Setting Up Chapter Breaks and Chapter 
Titles using Miscosoft Word
•	 Starting on a New Page, click the Page Layout tab and 

then click Breaks. Click the type of section break that 
you want to use. You can also choose to have your 
chapters start on a new right page by choosing  
Section Break: Odd Page. 

•	 Chapter “Sink” – The chapter text starts down in the 
middle or lower third of the page. This is usually done if 
the chapter starts on a right hand (or odd) page. A good 
way to create a Chapter Sink is to define a Chapter Title 
paragraph style that specifies the amount of spacing you 
want to appear before the title and use that consistently 
throughout your book. Use this approach rather than 
pressing return multiple times to create the sink.



PRE-PRESS MANUSCRIPT 
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Back Matter
Back matter is the material in the back of the book, after 
the last page of the narrative text. Like front matter, not all 
books have or require back matter.

In typical order of appearance, back matter can include the 
following:
•	 Epilogue 
•	 Afterword 
•	 Endnotes 
•	 Bibliography
•	 Glossary
•	 Index
•	 Author biography

Epilogue
An epilogue is a brief continuation of the main narrative or 
content of the book.

Afterword
An afterword is commentary on the book, usually written 
by someone other than the book’s author. An afterword 
might describe the historical context in which the book 
was written or provide some other kind of useful back-
ground material.

Endnotes
If the book included numbered reference notes that were 
not formatted as footnotes, they can appear in an endnotes 
section at the back of the book.

Bibliography
In nonfiction books, the bibliography lists all the sources 
that the author or authors consulted for their work.

Glossary
A glossary defines special or unusual terms in a book.

Index
An index is an alphabetical list of important topics from the 
book, along with citations of all the pages on which those 
topics appear.

Author Biography
A brief “About the Author” section might offer a brief biogra-
phy of the author.



This section provides tips for laying out a Microsoft Word 
document to make an aesthetically pleasing and profes-
sional looking book.

Planning the way a manuscript appears on the fixed book 
page is called “formatting,” or layout and design. Well-
thought-out design elements make your book  
aesthetically pleasing and easier for the reader to follow.  

For a quality, finished product, pay close attention to 
the consistency of your design. If you have a chapter 
heading style, use that style for each chapter header 
throughout the book. If you start your chapter halfway 
down the page, start all the chapters halfway down 
the page. Once you have finished designing the look 
of your book, make sure you go back and review the 
whole book for consistency in your design elements.

Format
You can choose whether you want a hardcover or paper-
back book. Each format has its own specifications to 
consider. Whichever format you choose you will need to 
provide a print-ready PDF of either the entire front, back, 
and spine, or just the front and back cover elements, and 
we can make the spine for you. Your cover files will likely 
have an image, title, author name, and any other text ele-
ments you choose to include. If your print book is for sale, 
it will need to include a barcode, but don’t worry, we add 
the barcode for you. For more detailed instructions on 
how to format your cover files see page 26.

Hardcover
If you choose a hardcover format, you can select to print 
with a Dust Jacket or with a Printed Case. 

•	 Dust Jacket: the dust jacket wraps around the case. 
Your cover file will be printed onto the removable dust 
jacket of your book.

•    Printed Case: the hard part of a hardcover book is called 
a “case.” Printed Case means your cover file will be 
printed directly onto the paper used to wrap the case of 
your book. 

Paperback
• 	 The Barnes & Noble Press print platform uses a stan-

dard paperback form with a glued spine binding. This 
type of binding is sometimes called perfect binding, 
creating a perfect-bound book.

Finish
• 	 You have a choice to make a cover with a matte or 

glossy finish, this is your preference. Also, if you print 
in black and white, your cover will automatically be 
printed in color.

LAYOUT AND DESIGN

10	 The Barnes & Noble Press Print Formatting Guide



Paper
Interior Ink Qualities
•	 Black & White – Most economical, printed on 50# 

(pronounced pound) paper in cream or white

•	 Standard Color – Standard color quality, printed on 50# 
or 70# white paper

•	 Premium Color – Highest color quality with more vivid 
color, printed on 70# white paper

Paper Color and Weights
•	 Cream 50# – Available for  B&W interiors, best suited 

for text-heavy books.

•	 White 50# – Available in B&W and standard color 
books

•	 White 70# — Available for premium color options

Premium color books are likely an illustrated children’s 
book or a comic book with a lower page count. Very 
expensive art books typically print using this option as well. 
The photo and illustration output is going to be of a higher 
quality than the standard color.

Standard color can be printed on 50 or 70# paper. The 50# 
paper is ideal for books with some minor  artwork but at a 
more economical price point than the thicker, 70# paper. 
Additional paper thickness is useful for an art book, chil-
dren’s book, or really anything that is going to have heavy 
ink coverage as the thicker paper will prevent 
bleed through.

Page Count and Trim Size
It’s important to consider the physical dimensions of your 
book when formatting your document. The height and 
width of a book is called its “trim size.”  Page count and trim 
size are closely related because the physical dimensions of 
the trim size affect the page size and therefore how many 
words will fit on a page (i.e., the smaller the page, the longer 
the page count). 

Page Count
The machines we use to print books have minimum and 
maximum page counts: 
• 	 Minimum Page Count: 18 pages
• 	 Maximum Page Count: 800 pages

NOTE: The page count includes all the pages of your interior 
text, regardless of which page actually is marked page 1.  
This section provides tips for laying out a Microsoft Word 
document to make an aesthetically pleasing and profes-
sional looking book.

LAYOUT AND DESIGN
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Below is a chart of the trim sizes, formats and text colors we offer. For each trim size, you can choose a cover with matte or glossy finish.

Trim Size	 Page	 Page	 Formats	 Printed Case	 Interior	  
	 Count	 Count	 	 or Dust Jacket	 Printing Color	 Paper Stocks
	 Min	 Max		  	 	               			                              

4” x 6”	 18	 800	 Paperback	 N / A	 B&W/Color	 B&W: White / Cream 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
4.25” x 7”	 18	 800	 Paperback	 N / A	 B&W/Color	 B&W: White / Cream 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
4.37” x 7”	 18	 800	 Paperback	 N / A	 B&W/Color	 B&W: White 50# 	
						      Standard Color: 50# / 70#		
5” x 8”	 18	 800	 Paperback/Hardcover	 Both	 B&W/Color	 B&W: White / Cream 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
5.06” x 7.81”	 18	 800	 Paperback	 N / A	 B&W/Color	 B&W: White 50#	
						      Standard Color: 50# / 70#		
5.25” x 8”	 18	 800	 Paperback	 N / A	 B&W/Color	 B&W: White / Cream 50#	
						      Standard Color: 50# / 70#		
5.5” x 8.25”	 18	 800	 Paperback	 N / A	 B&W/Color	 B&W: White / Cream 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
5.5” x 8.5”	 18	 800	 Paperback/Hardcover	 Both	 B&W/Color	 B&W: White / Cream 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#                  	                            
5.83” x 8.27”	 18	 800	 Paperback/Hardcover	 Printed Case	 B&W/Color                	B&W: White / Cream 50# 	
						      Standard Color: 50# / 70#		
6” x 9”	 18	 800	 Paperback/Hardcover	 Both	 B&W/Color                	B&W: White / Cream 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
6.14” x 9.21”	 18	 800	 Paperback/Hardcover	 Both	 B&W/Color                	B&W: White / Cream 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
7” x 10”	 18	 800	 Paperback/Hardcover	 Printed Case	 B&W/Color	 B&W: White 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
7.44” x 9.69”	 18	 800	 Paperback	 N / A	 B&W/Color	 B&W: White 50# 	
						      Standard Color: 50# / 70#		
7.5” x 9.25”	 18	 800	 Paperback/Hardcover	 Printed Case	 B&W/Color	 B&W: White 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
8” x 8”	 18	 800	 Paperback/Hardcover	 Printed Case	 B&W/Color	 B&W: White 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
8” x 10”	 18	 800	 Paperback/Hardcover	 Printed Case	 B&W/Color	 B&W: White 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
8.25” x 11”	 18	 800	 Paperback	 N / A	 B&W/Color	 B&W: White 50# 	
						      Standard Color: 50# / 70#		
8.268”x11.693”	 18	 800	 Paperback	 N / A	 B&W/Color	 B&W: White 50# 	
						      Standard Color: 50# / 70#		
8.5” x 8.5”	 18	 800	 Paperback/Hardcover	 Printed Case	 B&W/Color	 B&W: White 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
8.5”x 11”	 18	 800	 Paperback/Hardcover	 Printed Case	 B&W/Color	 B&W: White 50# 	
						      Standard Color: 50# / 70#	
						      Premium Color: 70#		
11” x 8.5”	 18 	 800	 Paperback/Hardcover	 Printed Case	 Color	 Premium Color: 70#		
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Trim Sizes
The most popular trim sizes for fiction and narrative nonfiction are shown below:
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5.83” x 8.27”
(14.8082 x 21.0058 cm)

6” x 9”
(15.24 x 22.86 cm)

5.5” x 8.25”
(13.97 x 20.955 cm)

5.06” x 7.81”
(12.8524 x 19.8374 cm)

5.25” x 8”
(13.335 x 20.32 cm)

5” x 8”
(12.7 x 20.32 cm)

5.5” x 8.5”
(13.97 x 21.59 cm)

4.37” x 7”
(11.0998 x 17.78 cm)

4.25” x 7”
(10.765 x 17.78 cm)

4” x 6”
(10.16 x 15.24 cm)

6.14” x 9.21”
(15.5956 x 23.3934 cm)

7.44” x 9.69”
(18.8976 x 24.6126 cm)

8” x 8”
(20.32x 20.32 cm)

8.25” x 11”
(20.955 x 27.94 cm)

8.268” x 11.693”
(21.0072 x 29.70022 cm)



LAYOUT AND DESIGN
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Trim Sizes
Depending on the type of book you are printing, there are other trim size options available. The trim sizes below are optimal for 
photo books, cookbooks, and children’s books.

8.5” x 8.5”
(21.59 x 21.59 cm)

8.5” x 11”
(21.59 x 27.94 cm)

8” x 10”
(20.32 x 25.4 cm)

7.5” x 9.25”
(19.05 x 23.5 cm)

7” x 10”
(17.78 x 25.4 cm)

11” x 8.5”
(27.94 x 21.59 cm)



6” x 9” (15.24 x 22.86 cm)

5.5” x 8.5” (13.97 x 21.59 cm)

5.83” x 8.27” (14.8082 x 21.0058 cm)

5” x 8” (12.7 x 20.32 cm)

4.25” x 7” (10.795 x 17.78 cm)

4” x 6” (10.16 x 15.24 cm)



6.14” x 9.21” (15.5956 x 23.3934 cm)

5.5” x 8.25” (13.97 x 20.955 cm)

5.25” x 8” (13.335 x 20.32 cm)

5.06” x 7.81”(12.8524 x 19.8374 cm)

4.37” x 7” (11.0998 x 17.78 cm)



8” x 10”
(20.32 x 25.4 cm)

7.5” x 9.25”
(19.05 x 23.495 cm)

7” x 10”
(17.78 x 25.4 cm)

8.5” x 11” (21.59 x 27.94 cm) 11” x 8.5” (27.94  x 21.59 cm)



7.44” x 9.69” (18.8976 x 24.6126 cm)

8.5” x 8.5” (21.59 x 21.59 cm)

8” x 8” (20.32 x 20.32 cm)

8.25” x 11” (20.955 x 27.94 cm)



How to Set Paper Size using Word on a Mac 
Choose Page Setup…under File from the top navigation bar. Under Paper Size choose Manage 
Custom Sizes…and then type in your specific trim size dimensions. 

Formatting for Trim Size
Once you’ve decided on your desired trim size, you need to designate those measurements in your interior document file. 
Setting the document/paper size will tell the printer how big to make your book page so it fits with your desired  
trim size. It’s very important to set these measurements.

How to Set Paper Size using Word on a PC 
Click the Page Layout tab and then click on the lower right button of the Page Setup  
section to open the complete dialog box:

15	 The Barnes & Noble Press Print Formatting Guide
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Click the Paper tab, select the custom size option 
and enter your desired measurements that match 
the trim size that you’ve chosen. In the drop-down 
menu next to “Apply to,” make sure to click on 
“Whole Document” to apply this size to the whole 
document.



Margin Size 
Margin settings in your book establish the white space that appears around the text. After you’ve set your document/paper size, 
you will need to set the margin size. You want to have enough white space so that the text doesn’t run off the book page. The 
standard margin setting is 0.5” on each side of the text except for the inside margin which should be 0.75”. 

Margin settings are set from the edge of the paper size you indicated so it’s important to set the document/paper size first.

Setting Margin Size using Word on a PC 
Click the Page Layout tab and then click on the lower right button of the Page Setup section to 
open the complete dialog box. Click the Margins tab and enter your desired margin measure-
ments. Choose your orientation and then select Mirror Margins in the “Pages” section. Click 
OK to apply these settings to the document. 

Setting Margin Size using Word on a Mac
Click on Layout from the navigation bar, then click on Margins. Choose Custom Margins...to set 
your margins and mirror margins in the same place. 
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Gutter
When a book page gets bound, the inner edges of the book 
pages are glued together. These inner margins are often 
called the “gutter,” and it’s important to leave enough room 
on the inside margin so that text doesn’t fall into the gutter. 
The longer the book, the thicker the book, and therefore, 
the bigger the inside margins should be.  

• 	 However, as long as you set the outside margins to 0.5” 
and the inside margin to 0.75”, then you DO NOT need 
to set an additional gutter. Set gutter to 0.0.”

• 	 “Mirror margins” is usually the best format option. 

Images
If you’re including images in your document, it’s important 
that they be high-resolution images, so that they print crisp 
and clear. We recommend saving images at 300 DPI (dots 
per inch) or higher.

Note that the color on your computer screen will not neces-
sarily match the color of your printed pages. Your computer 
screen shows projected RGB color (red, green and blue), 
and the printed books show CMYK color (cyan, magenta, 
yellow and black). 

Before printing a large numbers of copies, be sure to look 
over your print-ready file to ensure that the images appear 
how you want them, or even better, print out one copy of 
your book to start.

A Checklist for Images
Here is a checklist to make sure your images meet print-
ready requirements:
• 	Images must be at least 300 DPI to be considered 

print quality. 
• 	For full-bleed interior images (images that print to the 

edge of the page), a good bleed value is 0.125.” The bleed 
value is the margin beyond the edge of the page to which 
the image should extend in order to ensure that printing 
consistently reaches the edge of the page.

• 	 Images must be embedded into the document and not 
be a reference link. The file should include everything 
needed to print the file—images, fonts, and text.

• 	Remember that you must have the rights to all of the 
images you use.

• 	If you’re using Photoshop, InDesign or Illustrator, 

make sure your images are flattened to analog. Analog 
means that an image with multiple layers—designed 
using the above programs—has been condensed into a 
single layer. For instructions on flattening images see 
below. 

Converting a Multi-layer Image to Analog when 
using Photoshop, InDesign or Illustrator
To retain the richness and depth of a multi-layer image that 
you need to save as a flattened, analog version for your print-
ready PDF, you’ll need to save the image as a .psd or .png file. 
On a PC, you can click Control + A to select the entire im-
age, press Control + Shift + C to copy the selection as a single 
layer, and then press Control + V to paste the selection back 
into your workspace. That will give you the flattened layer 
you want, with the original layers still intact underneath.

Inserting Images Using Microsoft Word
To insert an image from a saved computer file or insert 
clip art, go to the Insert menu from the top navigation bar. 
Select Picture to insert an image from your computer or 
Clip Art to insert stock photography.  With the image se-
lected, go to the Format menu and select Format Picture. 
You can then format your image accordingly. 

Typeface/Fonts
Choosing the right typeface/font for your book is based on 
personal preference. However, certain fonts are better for 
reading and certain fonts are better for design. Whichever 
font you choose, it’s important to think about how the 
reader will consume it.

	 When talking about fonts, you will often hear the  
terms “serif” and “sans serif.” A serif typeface has little 
lines at the terminus of each stroke. A sans serif  
typeface does not. Typically, serif fonts are considered 
more readable and are good for the body text of your 
book. If you want to use sans serif fonts, they are  
typically better for chapter or section headers.
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Typefaces
Here are examples of popular serif typefaces, all set in 
eleven points. (Point sizes are explained below.)
•	 Garamond

	 The quick brown fox jumped over the lazy dog.
•	 Palatino
	 The quick brown fox jumped over the  

lazy dog.
•	 Times New Roman
	 The quick brown fox jumped over the lazy dog.
•	 Century

	 The quick brown fox jumped over the 
lazy dog.

Here are examples of popular sans serif typefaces, also set 
in eleven points.
•	 Arial
	 The quick brown fox jumped over the  

lazy dog.
•	 Helvetica
	 The quick brown fox jumped over the  

lazy dog.
•	 Verdana
	 The quick brown fox jumped over the 

lazy dog.

Font Size
The size of type is important for making sure your book is 
easy to read. Type is measured in points. Generally, keeping a 
font between 10 and 12 points for the body will result in an 
easily legible book. Feel free to experiment with large type 
sizes for chapter or section headings.

Line Spacing
Typically, line spacing is set between “single-spacing” and 
“1.5 lines” to make text legible without leaving too much 
white space between lines.  You can also specify line spacing 
in points. Generally, it’s best to have line spacing for the 
main text be at least 2 points larger than the font size. For 
example, if you’re using 11 point type, try setting the line 
spacing or line height to 13, 13.5, or 14 points.

Pagination
Pagination means numbering the pages in your book. To 
help your readers find their place in your book, we recom-
mend using pagination. 

Page numbers typically appear in the lower left corner of 
even-numbered pages and the lower right corner of odd-
numbered pages, but you can place them elsewhere if you’d 
like. Explore the Pagination tool in your word processor to 
discover which options are available to you.

Some publishers use lowercase Roman numerals (ie. i, ii, iii) 
to number pages in the front matter and then switch to tra-
ditional Arabic numerals (ie. 1, 2, 3) for the main narrative. 

If your book includes front matter, you have the choice of 
numbering the first page of your narrative page 1 or you 
can do as some publishers do and assign the first page of 
narrative the number it would have if you were numbering 
all pages, including the front matter, sequentially. Thus, front 
matter might run from page iii to page xxi, and the main nar-
rative might start on page 23.

The picture below shows how front matter such as a preface 
might be assigned page numbering in lowercase roman 
type. The main narrative begins with the next sequential 
number but set in Arabic numerals. You might want to look 
at how publishers you admire have assigned page numbers 
in their books to get an idea of how you want to assign page 
numbers in yours.
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Other Layout Elements to Consider
It’s easy to spend a lot of time trying to perfect your layout. Here are just a few more elements to consider as you work on 
your final design.

Running Headers/Running Footers
Running heads/running feet are the elements at the top or bottom of book pages. Typically, these sections can include things like 
the author’s last name, the book title, the title of the chapter, etc.  A common running head is the page number.

Applying Running Heads/Footers using Word on a PC
Open the Page Setup dialog box. Click the 
Layout tab and you will be able to adjust 
the layout, section start, alignment, and set 
values for headers and footers.
•	 Choose how you want a new  

section to start — Continuous, New 
Page, Odd Page or Even Page.

•	 Choose to set different text on odd 
and even pages, or a different first 
page. Then set the values for the 
header and footer.

•	 Choose the vertical alignment for 
the section (this is usually set to 
Top). Select if you want to use these 
settings for “This section” or “The 
whole document” and then click OK 
to apply.

Applying Running Heads/Footers using Word on a Mac
You can set the headers and footers of your book from the Document Elements section at the 
top of your toolbar. 
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Widows and Orphans
In typesetting, a widow is the last line of a paragraph when 
it appears by itself at the top of a page. The image below 
shows an example of a widow.
 

An orphan is either the first line of a paragraph  
appearing by itself at the bottom of the page, or a  
word or two appearing as the last line of a paragraph  
or as a line at the top of a page. The image below  
shows an example of an orphan. 

Traditionally, typesetters would try to avoid widows  
and orphans, because the white space around them  
can look awkward.

Microsoft Word features an on/off control for limiting wid-
ows and orphans. Go to Paragraph, then the Line and Page 
Breaks tab. Make sure the Widow/Orphan control check 
box is selected. 

Full Justification/Rag Right
Paragraph alignment is up to your personal preference. 
Books are often designed so that the left and right paragraph 
lines are flush to the margin or fully justified. 

When the right side of the text lines are allowed to  
appear jagged, this is called “ragged right” or “rag right.” 
Fiction and nonfiction are usually typeset fully justified, but 
much poetry is typeset ragged right. 

To set your text to fully justified go to the Home menu from 
the top navigation bar then go to the Paragraph section.  Se-
lect All to highlight your entire text then click on the button 
that says Justify when you hover over it.  

Crop Marks 
Crop marks are patterns of lines indicating where to trim 
(crop) the paper to a smaller document size. Your file does 
not need crop marks for the Barnes & Noble Press print 
platform, so please remove any crop marks before submit-
ting your file for printing.

LAYOUT AND DESIGN
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Now that your manuscript is formatted properly, you may 
want to save it as a PDF or you may want to leave as is in MS 
Word. If you do choose to convert it to a PDF, make sure to 
save your final manuscript as a word processing file too, just 
in case you need to edit something later. 

If you have installed a free PDF conversion tool like Adobe 
Acrobat on your computer, saving a Word document as 
a print-ready PDF is fairly straightforward, but there are 
some important steps you’ll need to take to create a type 
of PDF that’s compatible for the book printer. These steps 
include:
• Ensuring your Word file is not encrypted.
• Ensuring your fonts are embedded.

If you want to keep your document in Word, you will also 
need to ensure these two points are followed.

	 If you do not have Adobe Acrobat or another PDF  
conversion program installed on your computer, you  
can use an online PDF-conversion service available  
at www.adobe.com/createpdf.

Removing Encryption
Make sure there is no encryption on any aspect of the file, 
including the images. Encryption generally means password 
protection, so just be sure that none of your files is pass-
word-protected. 

If you have encrypted a file i.e., made it password- 
protected on your computer, you can remove file  
encryption by changing the file’s properties. 

Removing Encryption from a File on a PC
Locate the file from which you want to remove encryption. 
Right-click on the file, then click the Properties link in the 
context-menu to open a Properties window. Click the 
Advanced button. Click to uncheck the box next to Encrypt 
contents to secure data in the Advanced Attributes window. 
Click the OK button to close the Advanced Attributes win-
dow. Click the Apply button in the Properties window, then 
click the OK button. This closes the window and completes 
the encryption removal process.

Removing Encryption from a File on a Mac
Right click on the file by hitting Control + Click.  
Choose Get Info from the list that opens. Make sure  
the locked box is unchecked to ensure there is no  
password protection on your file. 

Embedding Fonts
The document needs to contain certain information so the 
printer knows how to render your book’s typeface. In some 
word processing software you need to specifically indicate 
that you want to embed your fonts in the document so that 
they render properly in your file. Thankfully, most word 
processing software makes this easy to do. 

Word for Mac does not have a font embedding option, so if 
you are using this program you should be able to save to PDF 
without formatting issues, provided your PDF software is set 
to the correct trim size (we’ll go over that later).

GENERATING A PRINT-READY FILE
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Embedding Fonts Using Word on a PC
From within a Word document, click the Office button in the top left corner of the  
screen. At the bottom of the dialog box that opens, click the Word Options button.  
Or, click File and then click Options.

Inside the Options section you will see the dialog box below. In the last section on the screen, 
select ‘Embed fonts in the file’ by checking the box. Leave the other two boxes unchecked. Click 
OK. The file will now save with fonts embedded.

GENERATING A PRINT-READY FILE
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	 Note: When using Microsoft Word, there are a number 
of methods for creating a PDF file. Generally speaking, 
they will produce the same result, but following the steps 
below will ensure your PDF is print-ready for the Barnes 
& Noble Press print platform if you choose to convert it. 

Setting PDF Dimensions
Before saving as a PDF, you must double-check that your 
Word document is going to save as a PDF with your 
desired paper size.  

Setting PDF Dimensions Using Microsoft Word on a PC 
From the Office button in the top left hover over Print, and then choose Print Preview.  
From the Page Setup section, click on the Size section to see the drop down menu. Then 
choose More Paper Sizes... Enter your desired trim size in the width and height sections. 

SAVING A FILE AS A PDF (OPTIONAL)
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Setting PDF Dimensions Using Microsoft Word on a Mac 
On the top navigation bar, click File → Print to open the Print dialogue box.  
Click on Page Setup… at the bottom left. 

Click on Paper Size and then  
Manage Custom Sizes…
Enter the Paper Size for the PDF  
you are creating.



File → Save As

Using Microsoft Word on a PC 
On the top navigation bar choose File → Save As and you will open the below dialog box. 
Choose PDF as the Save as type. Click on Options… and in the choices below PDF Options, 
check the box that reads “ISO 19005-1 compliant (PDF/A).”  After saving open the PDF and 
check each page to make sure it looks like you expected it to. 

Using Microsoft Word on a Mac 
From the top navigation bar, choose File, then Save As. Under Format, choose PDF. You can 
rename your file in the Save As box. Open the PDF and check each page to make sure it looks 
like you expect it to. 

SAVING A FILE AS A PDF (OPTIONAL)
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Use this checklist to ensure your PDF or MS Word file is ready for publication.

q	 Text has been spellchecked and proofread.
q	 Text formatting is complete.
		  o	 Spacing is controlled by paragraph styles and page breaks, not by 			 

		  spaces, tabs, or hard returns.
		  o	 Paper size has been set according to your desired trim size.
		  o	 Outside margins are set to 0.5” or a similar distance and inside margins 
			   are set to 0.75”.
		  o	 No crop marks appear.
q	 Images are ready.
		  o	 You own all the rights to the images in the book.
		  o	 All images are 300 DPI or higher.
		  o	 All images have been saved in an analog mode if you used Photoshop 
			   or Illustrator. 
		  o	 No images are encrypted.
q	 Pagination is ready.
		  o	 Odd-numbered pages appear on the right, even-numbered pages on 
			   the left.
		  o	 If front matter uses a different numbering scheme, that numbering is 
			   consistent and correct.
		  o	 Elements such as prefaces, forewords, and chapters all begin on 
			   odd-numbered pages.
q	 The file is either a PDF or an MS Word file.
		  o	� The paper size (selected page dimensions) matches a trim size supported by 

the Barnes & Noble Press print platform. 
		  o	 Fonts are embedded in the file. 
		  o	 Encryption is turned off.

PRE-PUBLICATION INTERIOR CHECKLIST
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A book’s cover is its first chance to intrigue readers, so it’s 
important to make sure that it accurately represents your 
book. The following includes helpful tips and instructions to 
ensure your cover turns out the way you want it to, while 
being a print-ready PDF.

A Print-Ready PDF Cover
Your book cover PDFs are separate files from your book 
layout file. Your book cover may consist of one element that 
includes front, back, and spine, or two elements (front and 
back) that you will create as separate files, but will ultimately 
be combined on the Barnes & Noble Press print platform 
into a single cover. If you’re not using one of our cover tem-
plates, the cover formatting instructions vary a bit depend-
ing on the type of cover you choose: Paperback, Hardcover 
with Dust Jacket, and Hardcover with Printed Case.

Front and Back Cover Elements
Every book cover is different, but almost all include the title 
and author’s name. It’s also common to see a subtitle, or 
endorsement quote when applicable. Expressing the tone of 
your book can be achieved by using a typeface that reflects 
the mood of your book, or an image that represents the 
storyline or theme. 

The back cover can include a variety of items, depending 
on your preference. Most include a book synopsis or 
endorsements, a brief about-line of the author (if not 
included inside the book), and a barcode or other pricing 
notes if applicable. We print your book’s barcode for you, 
so your cover file does not need to include one. You can also 
include your website, book specs and any other information 
you wish to share. For print books for sale, we add a barcode 
to the bottom right-hand side of your back cover, so be sure 
not to put important content in this area. If you have your 
own barcode and place it on the cover, we will still add a 
barcode to the bottom right hand-side of your back cover. 
If your print book is for personal use, you will see a white 
box on the bottom right-hand corner of your book where a 
barcode will go. This barcode will appear on your final book 
but is for internal purposes only.

The Spine
Similar to the front cover, the spine almost always includes 
the title and author’s name. Your spine will need to be a 
part of your single cover file, or you may construct the spine 
directly on the Barnes & Noble Press print platform as a 
separate file; if you choose to do so, after uploading your 
front and back cover files, you will be able to pick out the 
color of your spine and the text you would like to include.

For books with a page count below 48 pages, the spine is too 
small to include any text without it being cramped and hard 
to read.

Assembling a Print-Ready Cover
After creating your single cover file or your front cover and 
back cover files, upload them to the Barnes & Noble Press 
print platform. If you will be uploading a single cover/full 
cover file that you’ve previously used on another print plat-
form, be sure to create a new file that adheres to the overall 
page dimensions we provide on the Barnes & Noble Press 
print platform. Copy and paste the cover image into this new 
file and save it as a PDF. Upload this new PDF to our platform.

Helpful Tips & Templates 
To make your book formatting process easier, for single 
cover file uploads that include the front cover, back cover, 
and spine all in one file, you may use the helpful in-tool tips 
when you reach the Book Cover upload page. These tips will 
reflect your book’s designated trim size.

If you choose to create your cover using separate front and 
back cover files, we offer Microsoft Word front and back 
cover templates in the various trim sizes available for the 
Barnes & Noble Press print platform. Our templates are 
available at BNPress.com in the Cover section of
“Create a Print Book flow”.

CREATING A COVER
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How to Use the Barnes & Noble Press Print 
Platform Cover Templates (Front/Back 
Cover Files)
Choose the Barnes & Noble Press print platform cover tem-
plate that matches your book’s trim size. The front and back 
cover templates work similarly. Instructions for using the 6” 
x 9” front paperback cover template follow below. 
1.	 Save the template under a new name before getting 

started. 
2.	 The page size is set appropriately at 6.125” x 9.25”. 
3.	 The margins are set appropriately at ZERO.  

Any image or text that appears in the blue trim  
zone may get trimmed off. 

4.	 The page color is set to WHITE but can be adjusted by 
going to the Page Layout tab and using the  
Choose Page Color option. If you change a background 
color, make sure you go to the Office button (if you’re 
using a PC), then to Word Options in the bottom right. 
Choose the Display option, then Printing Options, and 
then select the box Print Background Colors and Images. 

5.	 You can adjust the font and font size for the book de-
scription and author bio. 

6.	 Insert an image into the image area by selecting the 
Insert Image/Photo option. 

	
	 a.	 Choose an image of at least 300 DPI from 
			  your computer.
	 b.	 Adjust the placement of the image by clicking just 		

outside of the image. 
	 c.	 Increase, decrease, or move around the dotted 		

	 blue box for desired placement of image. 
	 d.	 Adjust image size by clicking on the image. 
7.	 You can add additional text boxes for more text. 
8.	 Before saving as a PDF, delete the template Instructions 

and the Blue Trim Lines by clicking on them and hitting 
delete. You should now have only one page – your front 
cover image in this case – to save as a PDF. 

9.	 Embed your fonts. See page 18 for embedding instructions. 
10.	Save as a PDF file. Choose ignore if you get a message 

about printing outside the margins. 

Cover File Properties 
•	 Trim size refers to your chosen interior page size. 
•	 Your Cover Page Size will be different from your 
	 interior page size. The cover size is larger than the  

interior page size because it will be trimmed after printing. 
Your Cover Page Size will vary in dimensions depending on 
the type of cover you are creating.

CREATING A COVER
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Below is a chart indicating the correct paper size of your cover file according to the trim size you have chosen. If you’re creating 
a cover using separate front and back cover files, we strongly suggest using one of our cover templates to make cover creation 
easier. Our front and back cover templates are available at BNPress.com in the Cover section of “Create a Print Book flow”.

Cover Page Size

CREATING A COVER
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	 Paperback	 Hardcover with	 Hardcover with
Trim Size	 cover size	 Printed Case size	 Dust Jacket size                             

4” x 6”	 4.125” x 6.25”	 N / A	 N / A	                                        

4.25’ x 7”                     	 4.375” x 7.25”	 N / A                                       N / A                                                       

4.37” x 7”	 4.495” x 7.25”	 N / A	 N / A                                                        

5” x 8”	 5.125” x 8.25”	 5.954” x 9.5”	 5.688” x 8.5”                                       

5.06” x 7.81”	 5.185” x 8.06”	 N / A	 N / A	                                 

5.25” x 8”	 5.375” x 8.25”	 N / A	 N / A	                                        

5.5’ x 8.25”                     	 5.625” x 8.5”	 N / A                                       N / A                                                       

5.5” x 8.5”	 5.625” x 8.75”	 6.454” x 10”	 6.188”x 9“                                            

5.83” x 8.27”	 5.955” x 8.52” 	 6.767” x 9.832”	 N / A	                                           

6” x 9”	 6.125” x 9.25”	 6.943”x 10.5”	 6.688” x 9.5”                                       

6.14” x 9.21”	 6.265” x 9.46”	 7.079” x 10.71”	 6.828” x 9.71”                                      

7” x 10”	 7.125” x 10.25”	 7.943” x 11.5”	 N / A                                                        

7.44” x 9.69”	 7.565” x 9.94”	 N / A	 N / A                                                       

7.5” x 9.25”	 7.625” x 9.5”	 8.442” x 10.75”	 N / A                                                       

8” x 8”	 8.125” x 8.25”	 8.943” x 9.5”	 N / A                                                       

8” x 10”	 8.125” x 10.25”	 8.943” x 11.5”	 N / A                                                        

8.25” x 11”                                  8.375” x 11.25”	 N / A                            	 N / A                                                       

8.268” x 11.693”                         8.393” x 11.943”	 N / A                            	 N / A                                                       

8.5” x 8.5”                                   	8.625” x 8.75”	 9.443” x 10”                            N / A                                                       

8.5” x 11”	 8.625” x 11.25”	 9.443” x 12.5”	 N / A                                                        

11” x 8.5”	 11.125” x 8.75”	 11.938” x 10.063”	 N / A                                                        



•	 Margins will be set at ZERO for your cover files but you need to allow room for trimming. To make a specific book size, 
the printer cuts off the edges of the paper. If your content is too close to those edges, it can get cut off. You will want 
your cover image or design to extend all the way to the trimming zone so that your images and design completely fill 
the page. However, if you don’t want aspects of an image cut off, don’t put them on the very edge of the page in the 
trimming zone. If you keep your document in Word, you must also go through these steps to ensure that your MS 
Word doc saves as a print-ready file to use on our platform.

These are the Trim Zones for each format:

CREATING A COVER
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Top: 0.13”	
Bottom: 0.13”
Left: 0
Right: 0.13”

Front cover

Paperback Cover

Top: 0.13”
Bottom: 0.13”
Left: 0.13”
Right: 0 

Back cover

Top: 0.13”
Bottom: 0.13”
Left: 0.25” (fold zone)
Right: 0 

Back cover

Top: 0.13”	
Bottom: 0.13”
Left: 0
Right: 0.25” (fold zone)

Front cover

Hardcover with 
Dust Jacket 

Top: 0.63”
Bottom: 0.63”
Left: 0.63”
Right: 0.5” (cover hinge)

Back cover

Top: 0.63”	
Bottom: 0.63”
Left: 0.5” (cover hinge)
Right: 0.63” 

Front cover

Hardcover with 
Printed Case
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Measurements
If you choose not to use a Barnes & Noble Press print plat-
form cover template, the measurements of your front and 
back cover files are as follows: 

Paperback Cover
Set your cover paper size (front and back) according to your 
chosen trim size using the below chart. Margins should be 
set to 0. Allow for bleed room (trim zone) according to the 
chart below so that important (not your cover background 
design) images and text don’t get cut off. 

Paperback Cover 	
Use the same trim size you chose for your interior.
Paper Size		
	 Interior Trim Size	 Cover Size (front/back)         
	 4” x 6”	 4.125” x 6.25”                              
	 4.25” x 7”	 4.375” x 7.25”                              
	 4.37” x 7”	 4.495” x 7.25”                              
	 5” x 8”	 5.125” x 8.25”                              
	 5.06” x 7.81”	 5.185” x 8.06”                              
      5.25” x 8”        	 5.375” x 8.25”                              
      5.5” x 8.25”       	 5.625” x 8.5”                                                           
	 5.5”.x 8.5”	 5.625” x 8.75”                              
	 5.83” x 8.27”	 5.955” x 8.52”                              
	 6” x 9”	 6.125” x 9.25”                                
	 6.14” x 9.21”	 6.265” x 9.46”                              
	 7” x 10”	 7.125” x 10.25”                            
	 7.44” x 9.69”	 7.565” x 9.94”                              
	 7.5” x 9.25”	 7.625” x 9.5”                                 
	 8” x 8”	 8.125” x 8.25”                              
	 8” x 10”	 8.125” x 10.25”                           
	 8.25” x 11”	 8.375” x 11.25”                           
	 8.268” x 11.693”	 8.393” x 11.943”                           
	 8.5” x 8.5”	 8.625” x 8.75”                               
      8.5” x 11”             	 8.625” x 11.25”                           
	 11” x 8.5”	 11.125” x 8.75”                           

Trim Zone (area that might get trimmed off)	
	 Front Cover	 Back Cover                                   
	 Top: 0.13”	 Top: 0.13”                                      
	 Bottom: 0.13”	 Bottom: 0.13”                                
	 Left: 0	 Left: 0.13”                                      
	 Right: 0.13”	 Right: 0                                            
	 Gutter: 0	 Gutter: 0                                         
	 Mirror Margins: No	 Mirror Margins: No                      

Hardcover with Dust Jacket
Dust Jacket covers are the most complicated covers to 
layout without a template. We strongly recommend using 
a template to ensure that the final layout is correct. The 
Barnes & Noble Press print platform offers four trim sizes 
for Hardcover with Dust Jacket: 5” x 8”, 5.5” x 8.5”, 6” x 9” 
and 6.14” x 9.21.” For Dust Jackets, you can choose to print 
text or extend your cover design onto the jacket flaps. 

Set your cover paper size according to your chosen trim 
size using the below chart. Margins should be set to 0. Allow 
for bleed room (trim zone) according to the chart so that 
important (not your cover background design) images and 
text don’t get cut off. 

Hardcover with Dust Jacket	
Use the same trim size you chose for your interior
Paper Size		
	 Interior Trim Size	 Cover Size (front/back)         
	 5” x 8”	 5.688” x 8.5”                                  
      5.5” x 8.5” 	 6.188' x 9”                                                            
	 6” x 9”	 6.688” x 9.5”                                  
	 6.14” x 9.21”	 6.828” x 9.71”                                  

Trim Zone (area that might get trimmed off)	
	 Front Cover	 Back Cover                                   
	 Top: 0.13”	 Top: 0.13”                                    
	 Bottom: 0.13”	 Bottom: 0.13”                            
	 Left: 0	 Left: 0.25” (fold zone)                  
	 Right: 0.25” (fold zone)	 Right: 0                                      
	 Gutter: 0	 Gutter: 0                                    
	 Mirror Margins: No	 Mirror Margins: No                  
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Hardcover with Printed Case
Set the page size according to your chosen trim size using 
the below chart. Margins should be set to 0. Allow for bleed 
room (trim zone) according the chart so that important (not 
your cover background design) images and text don’t get cut 
off. 

Hardcover with Printed Case	
Use the same trim size you chose for your interior.
Paper Size		
	 Interior Trim Size	 Cover Size (front/back)          
	 5” x 8”	 5.954” x 9.5”                                                                                    
	 5.5” x 8.5”	 6.453” x 10”                                    
	 5.83” x 8.27”	 6.767” x 9.832”                                    
	 6” x 9”	 6.943” x 10.5”                                
	 6.14” x 9.21	 7.079” x 10.71”                                    
	 7” x 10”	 7.943” x 11.5”                              
	 7.5” x 9.25”                        8.442” x 10.75”                               
	 8” x 8”	 8.943” x 9.5”                                    
	 8” x 10”	 8.943” x 11.5”                              
	 8.5” x 8.5”                          	9.443” x 10”                                  
	 8.5” x 11”                           9.443” x 12.5”                               
	 11” x 8.5”	 11.938” x 10.063”                                    

Trim Zone (area that might get trimmed off)	
	 Front Cover	 Back Cover                                  
	 Top: 0.63”	 Top: 0.63”                                   
 	 Bottom: 0.63”	 Bottom: 0.63”                             
 	 Left: 0.5” (cover hinge)	 Left: 0.63”                                  
 	 Right: 0.63”	 Right: 0.5” (cover hinge)             
 	 Gutter: 0	 Gutter: 0                                      
 	 Mirror Margins: No	 Mirror Margins: No                  

Using Microsoft Word to Create a Front  
or Back Cover File 
Click the Page Layout tab and then choose Size to adjust 
the document size. You will most likely need to make this 
a custom size document. Under the Paper tab, input your 
paper size based on the preceding charts. Your cover mar-
gins will be set to 0.0”, but know that you need to allow 
room for trimming when the cover is cut. Then, without 
moving the typing cursor, click Insert in the menu bar, then 
click Photo or Picture → Picture from File to insert your 
cover image. Make sure your cover fonts are embedded 
(see page 22 for more details). Click Save As a PDF. 

Layout and Images
It’s important to remember that the trim zone might be cut 
off during printing, so be sure to keep your images and text 
within the trim size measurements, keeping them out of 
the trim zone, if you don’t want them to get cut off. Finally, 
double check to make sure any images used meet the same 
print resolution requirements as the manuscript. (See page 
17 for more information about Images.)
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Setting Page Sizes
Go to File from the top navigation bar, then click on Page 
Setup from the drop down menu. When the dialog box pops 
up, choose Manage Custom Sizes… from the Paper Size 
section. 

When the second dialog box pops up, click on the + sign to 
add your new custom trim size. Type in your desired Width 
and Height in the Paper Size section and then click OK. Click 
OK again to set your new custom trim  
size for your book. 

 

Creating Page Breaks
Go to Insert from the top navigation bar and then choose 
which type of break you want to insert e.g., Page Break. 

Setting Up Running Headers and 
Footers
In documents based on a Word Processing Template, running 
heads are the default until a Section Break is inserted.

To view the header, hover the pointer at the top of the page 
until the Header box appears. In Pages, you see headers 
and footers by choosing View -> Show layer. To see them in 
Pages for iOS, tap the Tools icon (a wrench) and tap Docu-
ment Setup.

The Header is there. Hover the cursor over the top of the 
page until you see a Header box. Or, turn on Show Layout 

(View > Show Layout).

In documents based on a Mac Pages Layout Template, you 
must turn on headers and footer explicitly. Hover near the 
top of the page or choose Show Layout to see the current 
settings for headers and footers.

Embedding Fonts 
If you’re using Pages, you don’t have to worry about embed-
ding fonts at this juncture. Once you save your document as 
a PDF, open the PDF in Preview, and then save it again. Your 
document is now saved with fonts embedded. It’s that easy.

Saving a File as a PDF
Open the File menu, select Save As and choose PDF from 
the Format drop-down menu. Click Save. Open the PDF and 
check each page to make sure it looks like you expect it to. 

APPENDIX A. Instructions for Authors Using Pages for Mac
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